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ПРЕДУПРЕЖДЕНИЕ 
Все права на информацию, предоставленную в данной инструкции, 

зарезервированы компанией GCC. Любое копирование, внесение поправок, 
переиздание без авторизированных дистрибьюторских прав запрещены. Все 

комментарии, вопросы или советы по внесению поправок в данную инструкцию 
могут быть направлены Вашему местному региональному представителю 

компании GCC. 
 
 
Издание 2.3. Март 08. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 

ВАЖНАЯ ИНФОРМАЦИЯ                                          
 
Наша компания благодарит Вас за приобретение режущего плоттера GCC Jaguar 
IV. Перед началом работы с оборудованием, ознакомьтесь с содержимым данной 
инструкции в целях соблюдения норм безопасности и правил эксплуатации и 
технического обслуживания оборудования. 
 
 
 
 
 Внимание   

МЕРЫ ПРЕДОСТОРОЖНОСТИ 
 

 С целью соблюдения безопасности, переносите плоттер так, как это показано 
на рисунке ниже. Не переносите оборудование, держась за зажимные 
крепления по краям. 

 

 
       ПРАВИЛЬНО            НЕПРАВИЛЬНО 
 

 Избегайте ударов и встряхивания держателя режущего инструмента, т.к. 
инструмент может выпасть. 

 Во время работы не прикасайтесь к подвижным частям оборудования (таким 
как каретка). Следите, чтобы длинные волосы были убраны должным образом, 
с целью избежания попадания их в подвижные части. 

 Кабель питания должен подключаться только к источнику сети, имеющему 
заземление. 

 Используйте только кабель питания, поставляемый в комплекте с 
оборудованием. Избегайте перегибов кабеля питания. 

 Не подключайте кабель питания через тройник или удлинители. Это может 
привести к его перегреву и поломке оборудования. 

 Храните рабочий инструмент вдали от детей. 
 Всегда устанавливайте прижимные ролики в соответствии с белыми метами, 
нанесенными на корпус плоттера. 
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ПРЕДУПРЕЖДЕНИЕ: 
 
При отпускании зажима ролика никогда не нажимайте на нижнюю и верхнюю 
клипсу одновременно (см. рис. ниже). 
 
 
      ПРАВИЛЬНО            НЕПРАВИЛЬНО 
 
      Нажатие вниз        Нажатие вниз 

 
      РОЛИК ЗАЖАТ           РОЛИК ЗАБЛОКИРОВАН 
 
 

 
  Нажмите клипсу вверх для освобождения ролика 
 РОЛИК СВОБОДЕН 
 
Примечание: 
В случае двустороннего зажима ролика, используйте пинцет или пассатижи для 
отжатия нижней клипсы давлением вниз. После отжатия, установите ролик в 
нужную позицию и зажмите должным образом. 
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1. ОБЩИЕ СВЕДЕНИЯ 
 
1.1. Введение 
 
Режущие плоттеры серии Jaguar IV разработаны для вырезания компьютерных 
объектов (изображений) на листовом или рулонном виниловом материале. 
 
Данная инструкция рассматривает следующие модели режущих плоттеров серии 
Jaguar IV: 
 

• J4 – 61 Для материала шириной: 85мм ~ 770мм 
• J4 – 101S Для материала шириной: 120мм ~ 1270мм 
• J4 – 132S Для материала шириной: 120мм ~ 1594мм 
• J4 – 183S Для материала шириной: 190мм ~ 1900мм 

 
1.2. Комплектация оборудования 
 
Упаковка Jaguar IV состоит из комплектующих элементов, перечисленных ниже. 
Пожалуйста, должным образом проверьте их наличие. В случае отсутствия 
какого-либо из них, обратитесь к Вашему региональному дилеру. 
 
Комплектующие Кол-во 
1. Режущий плоттер  1 
2. Стандартная комплектация (для моделей: J4–101S/ 
J4–132S/J4–183S), опциональная для модели J4 – 61: 
• Н-образная стойка 
• Стойка простая 
• Балка 
• Заглушка 
• Винты М6 
• Шестигранный ключ М5 
• Колесо 
• Инструкция по сборке 

 
 

1 
2 
1 
4 
24 
1 
4 
1 

3.  Установка подачи материала 
Комплектующие 183S/132S/101S 61 
Стойка (2шт) V V 
Держатель рулона (ДР) (2шт) V V 
Направляющая втулка для ДР (4шт) V V 
Опора для ДР (2шт) V V 
Шестигранный ключ М6 (1шт) V V 
Инструкция по сборке (1шт)  V 
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Шестигранный ключ М5 (1шт)  V 
Держатель настольный (ДН) (2шт)  V 
Пластиковые подставки (4шт)  V 
Винт М4 (4шт)  V 
Винт М6 (12шт)  V 
Шестигранный ключ М4 (1шт)  V  

4.  Стартовый комплект 
• CD пользователя 
• Кабель питания 
• Кабель передачи данных (RS-232C) 
• Кабель передачи данных (LPT) 
• Кабель передачи данных (USB) 
• Держатель ножа (установлен в каретке плоттера) 
• Нож (устанавливается в держатель) 
• Безопасный нож 
• Мягкая подкладка для резки винила 
• Пинцет 
• Перфокарта 

 
1 
1 
1 
1 
1 
1 
1 
1 
1 
1 
1 

 
 
1.3. Возможности оборудования 
 
Ниже перечислены основные сферы применения режущих плоттеров серии Jaguar 
IV. 
 
• Интерфейс через три порта подключения (USB, LPT, COM) на усмотрение 

пользователя. 
• Сила давления ножа до 600 грамм. 
• Скорость резки до 60”/сек. 
• Отслеживание материала до 10-ти метров. 
• Несколько языков панели управления. 
• Корзина для материала. 
• Усовершенствованная система резки по топографическим меткам (AAS). 
 
 
 
 
 
 
 
 
 
 
 



 
 
1.4. Общий вид оборудования. 
 
1.4.1. Вид спереди. 
 

Вал с насечками – 
перемещает материал 
вперед и назад во время  
работы. 

 

 9

Панель управления 
– состоит из 14 
клавиш, 1 индикатора 
и ЖК-дисплея. 

Каретка – перемещает 
установленный в нее нож 
для резки, а также 
инсталлированную на 
нее камеру.  

 
 
 
 
 
 
 
 
 
 
 
 
 

Желоб для 
лучшего 
скольжения 
материала. 

 
 
 
 
 

Рабочая плоскость 
– поверхность для 
зажима и подачи 
материала во время 
резки. 

Линия 
выравнивания – 
можно точно 
расположить материал 
ровно по этой линии. 

Катер протектор – 
защищает корпус 
плоттера от воздействия 
давления ножа при резке.

 
 
 
 
 
 
 
 
 
 
 



 
 
1.4.2. Вид сзади. 
 

 

Зажим – подъем 
или опускание 
прижимных 
роликов. 

Прижимные 
ролики – зажим 
материала во 
время резки. 

 
1.4.3. Общий вид. 
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Держатель 
рулона – зажим 
материала во 
время резки. 

Втулки портала 
держателя рулона 
– предназначены 
для направления 
материала при 
подаче с рулона. 

Балка – 
поддерживает 
стойки.

Зажим 
рулонного 
держателя 
– 
поддержива
ет 
держатель. Н-образная балка 

– поддерживает 
корпус плоттера. 

Стойка – 
поддерживает 
корпус 
плоттера.



 
 
1.4.4. Вид слева 
 

 
 

Выключатель питания -  [I]  - вкл., [O] – выкл. 

Разъем питания – подключение кабеля питания.

Предохранитель – 3Amp. 

1.4.5. Вид справа. 
 
 

 

COM-порт подключения (RS232C) – 
используется при подключении к 
компьютеру через последовательный 
интерфейс. 

USB-порт подключения – 
используется при подключении к 
компьютеру через USB интерфейс. 

LPT-порт подключения – используется 
при подключении к компьютеру через 
параллельный интерфейс. 
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2. ИНСТАЛЛЯЦИЯ. 
 
 
2.1. Меры предосторожности. 
 
Перед началом установки плоттера, ознакомьтесь с информацией, приведенной 
ниже. 
 
Примечание 1 
 

• Перед началом инсталляции, убедитесь, что тумблер питания находится в 
выключенном положении. 

• Перемещайте плоттер аккуратно, чтобы избежать повреждений. 
 
Примечание 2 Выберите соответствующее рабочее место плоттера перед 
началом его установки, которое будет соответствовать следующим условиям: 

• К машине должен быть свободный доступ с любой стороны. 
• Оставьте достаточно свободного пространства для размещения машины и 

аксессуаров. 
• Рабочая площадь должна быть устойчива и защищена от вибраций. 
• Температура в рабочем помещении должна быть в пределах от 10 до 35°С. 
• Влажность в помещении от 25% до 75%. 
• Берегите машину от мусора и направленного сильного потока воздуха. 
• Не допускайте попадания прямых солнечных лучей на корпус машины. 

 
Примечание 3  Подключение питания. 
Проверьте, совпадает ли вилка шнура питания с разъемом розетки напряжения. В 
противном случае, свяжитесь с Вашим региональным представительством GCC. 

• Вставьте вилку питания в розетку, имеющую заземление. 
• Вставьте другой конец шнура питания (штекер) в соответствующий разъем 

плоттера. 
 
2.2. Стойка для подачи гибкого материала. 
 
Данная стойка предназначена для моделей плоттеров J4-101S/132S/183S. 
 
Шаг 1. 
Проверьте наличие компонентов в стартовом комплекте: 

• Шестигранный ключ М6 – 1шт. 
• Шестигранный ключ М5 – 1шт. 
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• Винты М6 – 24шт. 
• Заглушки – 4шт. 
• Колеса – 4шт. 
• Инструкция по сборке – 1шт. 

 
Шаг 2. 

• Выньте плоттер и его аксессуары из картонной упаковки. 
• Установите стойки и балки 1, 2, 3, как это показано на рисунке ниже. 

 

 

Балка 

Стойки 

Н-образная 
стойка 

Рисунок 1 

Рисунок 2 
 
Шаг 3. 
Затем соедините части 1 и 2, вставив 4 крепежных винта в соответствующие 
отверстия Н-образной стойки, как это показано на рисунке 2. 
 
Шаг 4. 
Установите балку 3 перпендикулярно стойкам 2 и закрепите их винтами, 
установив их в соответствующие отверстия, как это показано на рисунке 3. После 
этого, собранная конструкция должна выглядеть как на рисунке 4. 
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Стойка 

Балка 

Рисунок 4

Н-образная 
стойка 

Рисунок 3 

 
Шаг 5. 
Извлеките режущий плоттер из картонной упаковки. Разместите его на 
собранную стойку. Как это показано на рисунке 5. 
 

 

Винты 

6 отверстий 
крепления 
винтов 

4 винта 

Крепление 
держателя 
рулона 

Рисунок 5

Рисунок 6

Шаг 6. 
Установите крепление держателя рулона винтами и затяните их на корпусе 
стойки, как это показано на рисунке 6. Пользователь может размещать рулон в 
различных позициях на свое усмотрение. 
 
Шаг 7. 
Установите два держателя рулона в соответствующие пазы на креплении 
(рисунок 7).  
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Крепление 
держателя рулонаДержатель 

рулона 

Рисунок 7
 
Шаг 8. 
В итоге, плоттер должен размещаться на стойках так, как это показано на рисунке 
8. 
 

 Рисунок 8 
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2.3. Настольная подача гибкого материала. 
 
Шаг 1. 
Проверьте наличие следующих компонентов в упаковке с комплектующими 
частями. 
• Держатель рулона – 2 шт.0 
• Втулка портала держателя рулона – 4 шт. 
• Крепеж держателя рулона – 2 шт. 
• Настольный кронштейн – 2 шт. 
• Пластиковая подставка – 4 шт. 
• Винт М4 – 4 шт. 
• Винт М6 – 12 шт. 
• Шестигранный ключ М4 – 1 шт. 
• Шестигранный ключ М5 – 1 шт. 
• Шестигранный ключ М6 – 1 шт. (для регулировки винтов держателя рулона) 
• Инструкция по установке рулонного держателя – 1 шт. 
 
Шаг 2. 
Используя шестигранный ключ М4, закрепите винтами М4 пластиковые 
подставки на крепежах держателя рулона (рис. 9). 
 

 

Крепежи держателей рулона 
Рисунок 10
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Винты М4 

Пластиковые 
подставки 

4 винта 

Рисунок 9 

Крепежи держателей рулона 

Кронштейны 

Винты М6 

Винты М6 
 
Шаг 3. 
С помощью шестигранного ключа М6, винтами М6 присоедините кронштейны к 
крепежам держателя рулона (рис. 10). 
 
 



 
 
Шаг 4. 
Опрокиньте плоттер на переднюю панель и установите крепления для держателей 
рулона в сборе, как это показано на рисунке 11. 
 

 

Крепления для держателей 
рулонов в сборе 

Отверстия 
для винтов 

Винты М6 

Рисунок 11 

Рулонные держатели
Рисунок 12

Шаг 5. 
Установите два рулонных держателя в соответствующие пазы в креплениях 
(рисунок 12). 
 
Шаг 6. 
Плоттер в сборе с кронштейнами должен принять следующий общий вид 
(рисунок 13). 
 

 Рисунок 13
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2.4. Установка ножа. 
 
На рисунке 14 изображен держатель ножа. Нажатием на механизм в верхней 
части держателя, извлеките нож из его нижней части. Убедитесь, что острие 
лезвия не касается пальцев. 

 

Механизм извлечения ножа
Настройка длины 
вылета лезвия 

Внешнее кольцо 

Рисунок 14 

Шаг 1. 
Установите лезвие ножа (рисунок 15). 
 

 
Рисунок 15 Рисунок 16  

Шаг 2. 
Надавите на лезвие ножа в держателе с нижней стороны (рисунок 16). 
 
Шаг 3. 
Установите нужную длину вылета лезвия ножа, поворачивая регулировочное 
кольцо настройки в направлении против или по часовой стрелке (рисунок 17). 
 

Примечание:  
значение точной длины выступа лезвия ножа 
должно быть на 0,1мм больше, чем толщина 
обрабатываемой пленки. Например, если 
толщина пленки 0,5мм, то лезвие ножа должно 
выступать из держателя на 0,6мм. Этого 
выступа достаточно, чтобы прорезать верхний 
слой пленки и в то же время не затрагивать ее 
подложку. 
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Рисунок 17
 



 
 
Шаг 4. 
Установите держатель вместе с ножом с место его расположения на каретку. 
Убедитесь, что положение внешнего кольца держателя ножа после установки 
соответствует положению его крепления на каретке (рисунок 18). Затем 
защелкните зажим (рисунок 19). 
 

 
 Рисунок 18 

Рисунок 19  
Шаг 5. 
Для изъятия держателя, выполните указанные шаги в обратном порядке. 
 
Шаг 6. 
При возникновении необходимости замены лезвия ножа, нажмите на механизм 
(кнопка сверху на держателе ножа) чтобы выдвинуть нож из держателя. 
 
Внимание! 
Качество реза с течением времени может ухудшаться, т.к. во время работы лезвие 
ножа теряет свою остроту и притупляется. Некоторые пользователи решают эту 
проблему увеличением силы давления ножа, но это может привести к его 
механической поломке. Исходя из этого, при изнашивании лезвия рекомендуется 
его заменить. Режущий нож относится к перечню расходных материалов и его 
замену следует проводить так часто, как это будет необходимо, при замечании 
ухудшения качества реза. Увеличение силы давления ножа также приведет к 
значительному ухудшению качества резки. Поэтому, для достижения высокого 
качества резки следите, чтобы нож был острым. 
 
2.5. Подключение кабелей. 
 
Связь режущего плоттера с управляющим компьютером осуществляется 
посредством USB (универсальный последовательный порт) порта, параллельного 
(LPT) порта или последовательного порта RS-232C (COM). В этой главе 
описывается, как правильно подключить режущий плоттер к управляющему 
компьютеру, используя любой из указанных портов подключения. 
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!! Важно: при подключении плоттера через USB порт, оба остальных (и 
последовательный COM, и параллельный LPT) будут неактивны автоматически. 
 

 

Параллельный порт 
Последовательный порт 

Универсальный USB порт

 Рисунок 20
 
 
2.5.1. USB подключение. 
 
Режущий плоттер поколения Jaguar IV оснащен встроенным USB портом, версии 
1.1. (Операционная система Windows 95 не поддерживает USB). 
  
 Установка USB драйвера. 

 
Внимание!! Не подключайте кабель USB к разъему плоттера до 
установки USB драйвера. 

 
a) Отложите USB кабель в сторону, не подключая его к плоттеру. 
b) Вставьте в дисковод установочный диск и в появившемся меню автозапуска 

выберите “USB Driver” для инсталляции USB драйвера. Установите драйвер, 
следуя появляющимся окнам. 

 
 Подключение 
Подключите USB кабель к плоттеру в соответствующий разъем. Другой конец 
кабеля вставьте в соответствующий разъем компьютера. 

 Драйвер для резки. 
Вставьте установочный диск в дисковод и выберите “Driver” в меню 
автозапуска для установки драйве работы с графическим редактором 
CorelDraw. 

 
2.5.2. Параллельное подключение (LPT). 
 
• Подключение через параллельный порт: 

1. Подключите кабель к плоттеру и рабочему компьютеру. 
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2. В панели настройки принтеров установите порт передачи данных LPT1 или 

LPT2. 
3. Отправьте задание для резки непосредственно на плоттер. Или используйте 

команды DOS, такие как TYPE или PRINT для передачи данных. 
 

Внимание!! Перед подключением кабеля порта передачи данных 
отключите питание плоттера. 

 
2.5.3. RS-232 подключение (COM). 
 
• Подключение RS-232 (последовательного) порта. 

1. Для пользователей персональных компьютеров или ноутбуков необходимо 
подсоединить кабель последовательного порта передачи данных к разъему 
COM1 или COM2 рабочего компьютера. 

2. Введите настройки параметров соединения в панели настройки принтеров 
Вашего рабочего компьютера. Подробнее см описание функции “Misc” в 
главе 3. 

 
Внимание!! Перед подключением кабеля послдовательного порта 
передачи данных отключите питание плоттера. 

 
2.5.4. Передача данных. 
 
Существует два способа передачи данных с рабочего компьютера на плоттер. 
 
Способ 1: Готовое задание на резку можно отправить с рабочего компьютера 

непосредственно на режущий плоттер. 
 
Способ 2: Большинство софт-программ для резки способны имитировать 

команды HP-GL или HP-GL/2, потому используйте команды DOS, 
такие как TYPE или PRINT для вывода текущего задания. 

 
Например, файл с разрешением PLT, разработанный в софт-программе Sing Pal 
может быть передан непосредственно из DOS и затем обработано плоттером. 
Перед отправкой данных непосредственно из DOS необходимо выполнить 
настройки протокола передачи данных между режущим плоттером и командной 
системой DOS MODE. Убедитесь, что Ваш персональный компьютер имеет тот 
же протокол связи, что и плоттер. Например: 
 
  MODE COM2: 9600, N, 8, 1, P 
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Затем используйте команду TYPE для передачи данных через порт COM2, если 
этот порт настроен как выходной порт по умолчанию. 
 
  TYPE  filename > COM2 
Примечание: 
Каждый раз при передаче данных через последовательный порт с помощью 
системы DOS, добавляйте командную строку AUTOEXEC.BAT для 
автоматического расширения функционирования команды MODE. Однако, 
введенные переменные в командную строку MODE должны соответствовать с 
требованиями Вашей рабочей софт-программы. Для получения более подробной 
информации см описание работы с системой DOS. 
 
 
 

3. ПАНЕЛЬ УПРАВЛЕНИЯ 
 
В этой главе описаны операционные клавиши, расположенные на панели 
управления режущего плоттера Jaguar IV и их функции. После подготовки 
машины к работе и выполнения всех действий, описанных в главах 1 и 2, все 
параметры панели управления настроены по умолчанию и соответствуют 
заводским настройкам производителя. 
 
3.1. ЖК-дисплей. 
 

 
 
Клавиша Функции 
ЖК-дисплей Выводит на экран сообщения о рабочем состоянии и 

ошибках. 
Световой индикатор Отображает состояние подключения питания. Индикатор 
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POWER горит при подключении питания и находится в 
выключенном состоянии, если питание на плоттер не 
поступает. 

4 клавиши 
направления 
(клавиши-стрелки) 

Перемещение положения, выбор функции или изменение 
настроек. 

ENTER Выбор текущего пункта меню или подтверждение 
введенного переменного значения параметров. 

PAUSE/RESUME Временная остановка резки или ее продолжение. 
ON/OFF LINE Сброс введенных параметров, выбор режима работы или 

остановка работы. 
OFFSET Настройка параметра смещения лезвия режущего 

инструмента. 
FORCE Настройка параметра силы давления ножа. 
SPEED Настройка параметра скорости резки и качества. 
CUT TEST Выполнение различных тестов резки. 
DATA CLEAR Очистка буфера памяти плоттера. 
TOOL SELECT Выбор инструмента. 
MISC Функции настройки. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
3.2. Меню режима работы “On-Line”. 
 
Включите питание плоттера 
 

 

Для выбора используйте клавиши ▲▼► 

Для выбора используйте 
клавиши ▲▼и ENTER для 
подтверждения настроек 

 
 

 24



 
 
3.3. Меню режима работы “Off-Line”. 
 
Нажмите On/Off Line для перехода в нужный рабочий режим. 
 

 

Значение от 5~600 с градацией 5 единиц (сила 
давления в граммах)

Значение от 0,000~1,000 с градацией 0,025 
единиц (мм)

Скорость: от 3~153 с градацией 3 единицы (см/сек) 

Настройки величин обрабатываемых символов: 
Draft, Fair, Normal, Fine, Small. 

Увеличение скорости: от 3~153, шаг 3 единицы (см/сек
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3.4. Пункты меню. 
 
Ниже описаны функции пунктов меню. 
 
Пункт меню 
или клавиша 

Функция Настройки По 
умолчанию 

-- Замер размеров материала -- 
Roll Измерение ширины материала Макс. пробег 

150м 
 

Edge Измерение ширины материала и намотка 
его обратно, пока передний датчик 
замера материала не сработает. 

Макс. пробег 
150м 

 

Single Измерение ширины и длины материала Макс. пробег 
10м 

 

-- Power -- 
 Отображает состояние подачи питания   

[Клавиши стрелки] 
 1. Перемещение каретки с режущим 

инструментом по направлениям X и Y. 
2. Выбор функций или введение величин 

значений настроек. 

  

[Enter] 
 1. Подтверждение выбранных 

параметров 
2. Задание нового начала координат в 

положении режущего инструмента. В 
режиме “Offline” установите каретку 
(клавишами направления) в требуемое 
положение, затем нажмите [Enter] для 
задания нового начала координат. В 
процессе задачи параметров значений 
координат X и Y, нажав клавишу 
[Misc] можно активировать точную 
настройку задачи координат. Нажав 
[Misc] повторно, можно отключить 
функцию (Fine-Tune). 

  

[Pause/Resume] 
 Незамедлительная приостановка резки. 

Продолжение резки при повторном 
нажатии [Pause/Resume] 

  

[Online/Offline] 
 1. Переход между режимами Online и Offline.   

 26



2. Остановка резки или сброс введенных 
настроек.  

При нажатии на эту клавишу, процесс резки 
остановится без возможности дальнейшего 
продолжения с данной точки. 

[Offset] 
 Введение или изменение значения 

смещения кромки режущего инструмента 
от центра начала координат осей. 

0,000~1,000мм 0,275мм 

[Force] 
 Введение или изменение значения 

параметра силы давления инструмента. 
5~600грамм 
шаг 5гр 

80гр 

[Speed] 
Speed Введение или изменение значения 

параметра скорости в горизонтальном 
направлении. 

3~153 см/сек 
шаг 3см/сек 

72 см/сек 

Up Speed Введение или изменение значения 
параметра скорости в вертикальном 
направлении. 

3~153 см/сек 
шаг 3см/сек 

72 см/сек 

Cutting Quality Задание параметра качества резки. 
При резке мелких символов используйте 
режим “Small Letter”. 
При резке на большой скорости 
используйте режим “Draft”. 

Draft, Fair, 
Normal, Fine, 
Small Letter 

Normal 

[Cut Test] 
Square Cut Выполнение тестовой резки из текущего 

положения режущего инструмента. Более 
подробно о настройке силы давления 
ножа и скорости резки см в главе 
“4.3.Настройка силы давления и значения 
Offset”. 

  

Recut: 
Повтор последнего задания без повторной 
пересылки данных. 

1~99; 
шаг 1 

 Repeat Last 
Plot 

Copy: 
Копирование последнего задания без 
повторной пересылки данных 
* Расстояние между двумя копиями 1мм 
* Если для продолжения резки 
оставшегося материала недостаточно, на 
ЖК-дисплее появится следующее 
сообщение: 

* Если обе функции одновременно 

1~99; 
шаг 1 
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 активированы, плоттер будет выполнять 
только последние настройки. 
2-points: 
Ручное позиционирование 2-х точек для 
резки по контуру 

  Mark Positions 

3-points: 
Ручное позиционирование 3-х точек для 
резки по контуру 

  

[Data Clear] 
 Очистка буфера памяти   

[Tool Select] 
Set Smoothing 
Cut 

Активация функции “гладкой” резки.  Активна 

Over Cut Активация функции надреза для 
облегчения дальнейшего снятия верхнего 
слоя материала 

0,00мм-
1,00мм 
шаг 0,05мм 

0,00мм 

Set Tangential 
Mode 

Режим имитации тангенциальной резки 
при обработке толстых материалов и 
резки мелких символов. 
Примечание: при установке значения 
Offset 0,000мм эта функция 
автоматически деактивируется. 

 Активна 

Допустимые командные настройки в 
софт-программе: 
Force, Speed, Cutting Quality и Offset. 

  Panel Setup 

Допустимые командные настройки на 
контрольной панели плоттера: 
Force, Speed, Cutting Quality и Offset. 

  

Restore Default Сброс всех введенных настроек и 
возвращение заводских настроек по 
умолчанию. 

  

Save Parameter Сохраняет последние установленные 
параметры резки 

Patterns 1~4 Pattern 1 

[Misc] 
Auto Unrolled 
Media 

Во избежание защемления бумаги и 
поломки моторов предусмотрена 
автоматическая размотка материала (50 
см и обратно) перед началом резки. 
* Авторазмотка предусмотрена только 
для рулонных материалов. 
* При работе в режиме Single эта функция 
автоматически становится неактивной. 
* Рекомендуется отключить эту функцию, 
если длина рулонного материала менее 2-
х метров или вес материала слишком мал. 

 Активна 
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AAS Offset В этом меню можно изменять или 
задавать значение офсета AAS. 
Подробнее см главу “5.3 Распечатка 
теста”. 

  

Media Back & 
Forth 

Помогает сократить время рабочего цикла 
при выполнении повторяющегося 
задания. После окончания резки материал 
отматывается в исходное положение. 

 Неактивна 

Paper Saving 
Mode 

Предлагается четыре режима сохранения 
параметров материала: 
1. Length expanded mode. 
2. Width expanded mode. 
3. Both expanded mode. 
4. Both unexpanded mode. 

 Both 
Unexpanded 
Mode 

Set 
Communication 

Построение связи между рабочим 
компьютером и плоттером. 
9600, n, 7, 1, p 9600pbs, 7 Bits with NO 
Parity 
9600, o, 7, 1, p 9600pbs, 7 Bits with ODD 
Parity 
9600, e, 7, 1, p 9600pbs, 7 Bits with EVEN 
Parity 
9600, n, 8, 1, p 9600pbs, 8 Bits with NO 
Parity 
9600, o, 8, 1, p 9600pbs, 8 Bits with ODD 
Parity 
9600, e, 8, 1, p 9600pbs, 8 Bits with EVEN 
Parity 
19200, n, 7, 1, p 19200pbs, 7 Bits with NO 
Parity 
19200, o, 7, 1, p 19200pbs, 7 Bits with 
ODD Parity 
19200, e, 7, 1, p 19200pbs, 7 Bits with 
EVEN Parity 
19200, n, 8, 1, p 19200pbs, 8 Bits with NO 
Parity 
19200, o, 8, 1, p 19200pbs, 8 Bits with 
ODD Parity 

19200, e, 8, 1, p 19200pbs, 8 Bits with 
EVEN Parity 

  

Firmware 
version 

Вывод на экран версии прошивки и 
кодировки FPGA 

  

Select 
Language 

На ЖК-дисплее отображается выбор 
языковой панели: английский, испанский, 
итальянский, немецкий, японский, 
португальский, польский, турецкий или 

 English 
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французский. 
Select Units Выбор системы измерений величин см/гр 

inch/oz 
Metric 

Scale Length 

Scale Width 

Установка линейной шкалы измерения 
длины и ширины материала в 
зависимости от его толщины. 

Denominator (знаменатель) – фактическая 
реальная длина материал, Numerator 
(числитель) – идеальная длина, 
замеренная автоматически. 

Рассмотрим пример резки прямой линии, 
длиной 500мм. Процедура будет 
выглядеть следующим образом: 
1. Нажмите клавишу ◄ для выбора 

значения Numerator и выберите 
500.0мм. 

2. Выполните резку линии из 
графического файла. 

3. Замерьте длину вырезанной линии, 
затем, используя клавишу ►, 
выберите полученной значение в графе 
Denominator, затем 

4. Нажимая клавиши ▼ или ▲, выберите 
нужное значение фактической длины 
отрезанной линии. 

  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 

4. РАБОТА НА ПЛОТТЕРЕ. 
 
 
4.1. Загрузка материала. 
 
4.1.1. Загрузка листового материала 
 
Для загрузки материала должным образом выполните действия, описанные ниже. 
 
Шаг 1. 
Для того чтобы поднимать или опускать прижимные ролики воспользуйтесь 
рычагом, расположенным в правой верхней части плоттера. Тяните рычаг вперед 
то тех пор, пока не раздастся щелчок, прижимные ролики поднимутся вверх. 
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Шаг 2. 
Расположите материал на рабочем столе или рулоне и задвиньте передний край 
материала под прижимные ролики с передней или задней стороны. Цветные 
метки на рабочей плоскости зажимов помогут правильно расположить материал. 
 

 
Примечание:  
Убедитесь, что полотно 
материала покрывает сенсоры 
замера материала. По меньшей 
мере, один из двух датчиков 
должен быть закрыт. Плоттер 
будет автоматически производить 
замер материала по длине и 
ширине, в то время, пока сенсор 
находится накрытым. 

Рычаг 

 
 
 
 
 
 
 

 
 

Датчики замера 
материала 

 



 
 
Шаг 3. 
После этого вручную установите прижимные ролики в нужные положения. 
Убедитесь, что ролики установлены в положениях над открытыми участками 
металлического вала с насечками. Белые метки на верхней балке указывают 
правильное расположение прижимных роликов (см рис ниже). 
 

 

Белые метки 

 
Шаг 4. 
Опустите рычаг зажима роликов в нижнее положение, ролики опустятся в 
фиксирующее положение. 
 
Шаг 5. 
Включите питание плоттера, каретка с инструментом произведет замер материала 
автоматически. Плоттер готов к работе. 
 
Примечание: 
1. Положение прижимных роликов всегда устанавливайте только при поднятой 
фиксирующей балке, на которой находятся ролики (используйте рычажной 
механизм для поднятия и опускания балки). 
2. Перемещайте ролики, применяя усилие только с задней стороны балки. 
3. Не пытайтесь переместить прижимные ролики, зажимая их с передней части 
балки. 
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НЕПРАВИЛЬНО

 
 
4.1.2. Загрузка рулонного материала. 
 
Шаг 1. 
Закрепите втулки на двух держателях для рулона. 
 

 

Втулки портала рулонного материала 

Шаг 2. 
 
-- Вариант А (рекомендуемый) 
Установите два держателя рулона на подставки и положите рулонный материал 
непосредственно между ними. 
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-- Вариант В (использование боковых зажимов материала) 
Установите боковые заглушки по краям 
рулона и затяните их до той степени, пока 
рулон не будет крепко зажат с боков. 
Затем положите рулонный материал на 
держатели таким образом, чтобы кромки 
боковых заглушек совпадали с пазами на 
втулках. 
 
 
 
 
 

  
 
 
 
 
 

  
 
 
Шаг 3. 
Загрузите материал на валик (см раздел “4.1.1. Загрузка листового материала”). 
После загрузки материала натяните его, удерживая полотно с передней части и 
подтягивая его со стороны рулона. 
 

 

 
 

 

 34



 
 
Шаг 4. 
Натяните материал, вращая рулон таким 
образом, чтобы полотно материала бы 
натянуто равномерно по всей плоскости. 

Примечание: 
Убедитесь, что натяжение 
материала одинаково распределено 
по всей его плоскости слева 
направо. Слабо натянутый материал 
может послужить причиной 
возникновения неисправностей. 
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Шаг 5. 
Установите прижимные ролики в нужные 
позиции над открытыми участками вала, 
согласно белым меткам. 
 
Шаг 6. 
Опустите рычаг балки держателя прижимных роликов. 
 
Шаг 7. 
Плотно зафиксируйте рулон с материалом боковыми заглушками на держателях 
рулона. 
 
Шаг 8. 
Включите питание плоттера, каретка с инструментом произведет замер материала 
автоматически. Плоттер готов к работе. 
 
Шаг 9. 
Для снятия материала выполните указанные шаги в обратной 
последовательности. 
 
4.2. Эффективность размотки материала. 
 
Для достижения наивысшего качества работы плоттера необходимо следить, 
чтобы натяжение материала и его подача были равномерны. С этой целью ниже 
приведены некоторые советы: 
 
Если длина материала менее четырех метров, при его фиксации прижимными 
роликами, оставляйте с левого и правого краев по 0,5 – 25мм. 
 

 
Прижимной 
ролик 

Прижимной 
ролик 

 



 
 
Если длина материала более четырех метров, при его фиксации прижимными 
роликами, оставляйте с левого и правого краев по 25мм. 
 

 

≥ 25 мм ≥ 25 мм  

 
Подробнее см раздел “4.5. Обработка длинномерного материала”. 
 
4.3. Сила давления и значение “Offset”. 
 
Перед отправкой задания для резки на плоттер Вы можете выполнить тестовую 
резку “Cut Test” для того, чтобы добиться удовлетворительных результатов. 
Тестировать резку можно до тех пор, пока не добьетесь удовлетворительных 
результатов. 
 
После произведения замеров материала нажмите клавишу [CUT TEST], выберите 
“Square Cut” и нажмите [ENTER] для подтверждения. 
 
По умолчанию значения величин силы давления и офсета составляют 80гр и 
0,275мм соответственно. Пользуясь клавишами стрелками, Вы можете 
перемещать рабочий инструмент в любое удобное для проведения тестовой резки 
место. Затем нажмите клавишу [ENTER] для выполнения теста. 
 
Примечание: новое положение начала координатного отсчета будет 
соответствовать начальной точке при тестовой резке. 
 
После завершения резки образцы шаблонов готовы. Проверьте качество резки, 
легко ли отделяются вырезанные образцы от подложки материала, все линии 
прорезаны одинаково глубоко. Если да, то примите установленное значение силы 
давления ножа как требуемое для резки данного материала. И пользуйтесь им в 
дальнейшем. Если линии оказались недорезанными или слишком глубокими, то 
клавишу [FORCE] и изменяйте значение силы давления, до тех пор, пока 
оптимальное значение не будет достигнуто. Образцы тестовой резки 
представлены на рисунке ниже. 
Если получившиеся шаблоны похожи на образцы резки ВВ или СС, нажмите 
клавишу [OFFSET] и пробуйте различные значения офсета до тех пор, пока не 
получите аналогичный образец АА. 
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Нажмите Enter 

Нажмите Enter 

Нажмите Speed, 
Force, Offset для 
установки или 
клавиши стрелки 
для выбора 
следующей 
позиции резки. Нажмите Enter 

 
4.4. Резка 3-х мм символов. 
 
Для достижения высокого качества конечного результата при резке мелких 
символов (напр. 3мм), рекомендуется использовать узкие полоски материала. 
Однако если используется широкий материал, необходимо: 

1. Расстояние между двумя прижимными роликами должно быть как можно 
меньше. 

2. Убедитесь, что загруженный материал плотно зажат и достаточно хорошо 
натянут по всей рабочей плоскости. 

3. Рекомендуемые настройки параметров: 
Force: 55гр (или в зависимости от типа материала) 
Speed: 45-50 см/сек 
Tool up speed: 45-60 см/сек 
Smooth cut: Disable Cutting 
Quality: Small Letter 
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4.5. Резка длинномерного материала. 
 
При резке длинномерного материала с рулона, такого, например, как тяжелая и 
толстая виниловая пленка, необходимо использовать функцию “AUTO UNROLL 
MEDIA”. 
 

1. Если длина изображения от 3-х до 5-ти метров, параметр скорости резки 
лучше установить чуть менее 45 см/секи параметр “Cutting Quality” 
рекомендуется установить “Normal”. 

2. Если длина более 5-ти метров, скорость резки (параметр “Speed”) 
рекомендуется задать менее 30 см/сек. 

3. После загрузки рулонного материала все прижимные ролики должны 
плотно фиксировать материал по всей его передней кромке. 

 

 
 
Затем потяните рулон в обратную сторону, чтобы натянуть поверхность 
материала. 

 
Убедитесь, что натяжение 
материала равномерно по всей 
поверхности слева направо. 
Если натяжение материала 
недостаточно, это может 
привести к  возникновению 
неисправностей. 
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4. Зафиксируйте прижимные ролики. 
5. Боковыми заглушками закрепите рулон с материалом, как это было описано 

выше. 
6. Выступающая часть лезвия ножа должна быть больше, чем толщина 

винила. Подробнее см Приложение 2 “Спецификация ножей”. 
 
 

5. РАБОТА С ОПТИЧЕСКОЙ КАМЕРОЙ 
 (AAS). 
 
5.1. Введение. 
 
Режущие плоттеры серии Jaguar IV оснащены системой оптической приладки 
(AAS II) – оптической камерой. Она предназначена для выполнения резки по 
ранее напечатанному контуру, следуя топографическим меткам, которые камера 
способна распознавать. 
 

Примечание 
 Избегайте попадания прямых солнечных лучей на модуль AAS. 

 

- ЗАПРЕЩЕНО
 

- ДОПУСТИМО 
 

 Во время процесса работы НЕ СНИМАЙТЕ крышку модуля AAS. 
 

 
- ЗАПРЕЩЕНО
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5.2. Калибровка камеры. 
 
Для достижения максимальной точности работы AAS модуля требуется 
выполнить процедуру его калибровки. Но сначала необходимо подробно 
ознакомиться с описанием метода загрузки материала (раздел “4.1. Загрузка 
материала”). 
 
5.2.1. Приладка материала. 
 

Калибровка материала необходима для того, чтобы удостовериться в 
способности оптического датчика камеры распознать 
топографические метки. Заводские настройки по умолчанию 
рассчитаны на широкий спектр материалов. Однако некоторые виды 
материалов не подходят под общие условия настроек по умолчанию. 
Калибровка материала необходима для того, чтобы изменить 
чувствительность датчика в отношении к тому или иному 
нестандартному типу материала. Точная калибровка материала 
способствует достижению высокой точности работы модуля AAS в 
процессе резки. 

 
 Когда необходимо применять. 
Для достижения лучшего результата рекомендуется использовать 
материал белого цвета. Нет необходимости выполнять калибровку 
материала каждый раз, кроме случаев, в которых датчик камеры 
оказывается нечувствительным к распознанию меток на материале. 

 
5.2.2. Калибровка AAS модуля. 
 

Для того чтобы топографические метки распознавались камерой, 
необходимо печатать их отличными от всего остального изображения. 
При разработке меток необходимо учитывать следующее: 
 Создание метки 
 Соответствие типа материала 
 Позиционирование метки на материале 

 
Топографические метки должны быть: 
 Черного цвета 
 Длина 20~25мм 
 Ширина 1мм 
 Отступ 5мм 
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  Датчик не распознает метки, если: 

 Толщина материала более 0,8мм 
 Используется прозрачный материал 
 Неоднотонность метки. Метка также не может быть считана, если 
напечатана на цветном материале. 

 Поверхность материала мятая или запачкана. 
 
5.2.3. Система AAS II на плоттере Jaguar IV. 
 
Существует три шаблона топографических меток системы AAS: 4-Point Position, 
Segmental Position и Multiple Copies. (См Приложение 3 “Инструкция по работе с 
CorelDraw”). 
 
1. 4-Point Position. 

Это основной шаблон печати топографических меток для выполнения резки 
контура, заключенного в пределы этих меток. 
 Команда: Esc.D1;(XDist);(YDist): 
 Расположение: 4 L-образные метки по 4-м углам изображения 

 
 
2. Segmental Position 

В дополнение к 4-м основным меткам можно создать промежуточные по 
обеим осям Х и Y, которые помогут более точно обозначить контур, особенно 
для изображений больших размеров. 
 Команда: Esc.D2;(XDist);(YDist);(XStep);(YStep) 
 Расположение: 
По оси Х в промежутке 200-600мм, по умолчанию 300мм 
По оси Y в промежутке 200-600мм, по умолчанию 300мм 
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3. Multiple Copies 

Эта функция позволяет вырезать изображения, отличные друг от друга 
одновременно. Оптический датчик модуля AAS автоматически распознает 
метки каждого отдельно взятого изображения. 

 
 Команда: Esc.D3;(XCopies);(YCopies);(Space) 
 Расположение: 

 
Вариант 1 (по умолчанию)         Вариант 2 

 
 
5.3. Распечатка теста. 
 
Для того чтобы убедиться в точности работы AAS модуля, перед началом 
выполнения резки по топографическим меткам рекомендуется выполнить резку 
по тестовым файлам, которые Вы сможете найти на прилагающемся 
установочном диске. 
 
На диске Вы сможете найти два тестовых файла: 
1. AAS II_X_Y_Offset_Caberation_A4.eps (формат А4) 
2. AAS II_X_Y_Offset_Caberation_600_600.eps (настройка по умолчанию, 

рекомендуется для первичной тестовой резки) 
 
 Распечатайте тестовый файл. (Используйте принтер высокой четкостью 
печати). 

 Загрузите тестовый файл для резки в буфер памяти плоттера. 
 Если необходимо ввести изменения в настройки параметра офсета, выполните 
следующие действия: 
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∗ Измерьте значение Offset (отступ между напечатанной линией и 
действительной линий резки). 

∗ В меню MISC в разделе AAS OFFSET введите только что измеренное 
значение. Нажмите ENTER. 

∗ Выполните резку тестового файла снова. 
∗ Введенные переменные значения Offset обозначают: 

Горизонтальную линию по координате Х и вертикальную линию по 
координате Y. 

∗ Если действительные координаты линии реза и линии напечатанного файла 
необходимо сместить по направлению к началу координат, то значение 
отступа вводится с отрицательным знаком. Если координаты нужно 
сместить в направлении ОТ установленного начала координат, то 
переменные вводятся с положительным знаком. Этот метод применим к 
обеим координатам X и Y. 

 
Например: 
Веденные значения в плоттер, Х: 0.50мм; Y: 0.50мм, а измеренные значения 
соответствуют, X1: - 0.25мм; Y2: +0.25мм. (На рисунке эти координаты 
обозначены синим и красным цветами). 
Необходимо ввести следующие новые настройки Offset X new: (X+X1) Y new: 
(Y+Y1), которые соответствуют X new: 0.25mm, Y new: 0.75mm. Затем 
сохраните введенные новые параметры в плоттере. 

 

 43
 

Начало координат 



 
 
 Перед настройкой модуля AAS II выполните масштабирование по длине и 
ширине. 

 Вылет лезвия изначально не настроен для тестовой резки, установите его на 
необходимую длину. 

 При возникновении каких-либо вопросов по настройке модуля AAS II 
обратитесь к Вашему региональному дистрибьютору GCC. 

 
 
5.4. Резка по контуру. 
 
Для выполнения точной резки по контуру с помощью оптического модуля AAS, 
необходимо выполнить следующие шаги: 
 
Шаг 1. Создание изображения. 
 

 В графическом редакторе создайте изображение, которое 
собираетесь распечатать. 

 
 

 Затем создайте контур предполагаемой резки вокруг изображения. 

 
Примечание 1: Оставьте некоторый зазор между контуром резки и 
границей изображения. 
Примечание 2: Контур для резки должен создаваться на отдельном 
от изображения уровне и выполнен другим цветом. 

 
 Создайте метки вокруг изображения. 
Примечание: 
Также доступна функция Multiple Copies, с помощью которой можно 
автоматически копировать изображение и метки. 

 
Шаг 2. Размещение топографических меток. 
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∗ Метка, расположенная на сером фоне, будет автоматически распознана как 

начало координат. 
 Следует оставить отступы по 30мм с левой и правой стороны 
рабочего листа материала. 

 Следует оставить отступы 25-30мм от верхней кромки и 50мм от 
нижней кромки рабочего листа, чтобы избежать ошибок при 
замере материала. 

 
Шаг 3. Печать изображения 
 

 Распечатайте подготовленное изображение с топографическими 
метками. 
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Масштабирование 100% 
Шаг 4. Загрузите напечатанный материал на плоттер. 

 
 Первая метка (начало координат) отличается от всех остальных 
меток. Убедитесь, что материал загружен в правильном 
направлении. 

 

 
 
Шаг 5. Резка контура 

 Из софт-программы отправьте команду выполнения резки по 
контуру. 

 
5.5. Подсказки при работе с модулем AAS. 
 
Для достижения лучшего результата, ниже приведены несколько подсказок при 
выполнении резки по контуру. 
 

 Источники освещения не должны располагаться со стороны 
плоттера. 

 Перед началом работы с оптическим модулем в драйвере плоттера 
Jaguar IV измените максимальный размер листа 
Шаг 1. В закладках “Принтеры и факсы” рабочего компьютера 
найдите модель Jaguar IV. 
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  Шаг 2. Зайдите в меню “Свойства” и выберите строку “Paper”. 
  Шаг 3. Измените максимальный размер листа Х на 1 200мм. 

 Задайте параметр скорости в пределах от 300-600мм/сек 
 Старайтесь избежать расположения топографических меток в 
местах зажима прижимных роликов. 

 
 

6. ОБСЛУЖИВАНИЕ ПЛОТТЕРА. 
 
Эта глава заключает в себе основные моменты в обслуживании режущего 
плоттера. Все действия, за исключением описанных ниже, должны проводиться 
квалифицированным сервисным специалистом. 
 
6.1. Чистка плоттера. 
Для продления срока службы Вашего плоттера необходимо регулярно должным 
образом производить его чистку. 
 
Меры предосторожности! 
 

• Перед проведением чистки отключите 
электропитание плоттера, чтобы избежать 
электрического удара. 

• Для чистки плоттера никогда не используйте 
растворители и абразивные материалы. Это 
может привести к повреждению поверхности 
плоттера и его комплектующих. 

 
Рекомендуемые способы: 
• Аккуратно протирайте поверхность плоттера безворсовой салфеткой. Если это 

необходимо, смочите ее водой или спиртом. Затем протрите поверхность 
сухой тканью. 

• Протирайте каретку, держатель ножа и Х-портал. 
• Для удаления скоплений мусора и пыли используйте пылесос. 
• Протирайте датчики материала, прижимные ролики и рабочую область 

смоченной в воде или спирте безворсовой салфеткой. 
• Удаляйте мусор и пыль со станины. 
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6.2. Чистка вала. 
 

1. Отключите питание плоттера и отодвиньте каретку от тог места, которое 
необходимо чистить. 

2. Поднимите прижимные ролики и отодвиньте также в сторону от места 
чистки, освободив, таким образом, доступ к открытым участкам вала. 

3. Для удаления мусора с поверхности вала используйте ворсистую щетку 
(например, зубную). Во время чистки вручную вращайте вал. 

 

 
 
6.3. Чистка прижимных роликов. 
 

1. Если необходимо провести чистку прижимных роликов, используйте 
безворсовую салфетку или ватные палочки для протирки резиновых частей 
ролика. 

2. для удаления глубоко въевшегося мусора и пыли смочите ватные палочки 
спиртом. 

 
Примечание: Важно проводить чистку плоттера ежедневно. Перед началом 
работы, убедитесь, что прижимные ролики и вал находятся в чистом виде. Это 
позволит продлить срок службы плоттера и повысить качество его работы. 

 
 

7. УСТРАНЕНИЕ НЕИСПРАВНОСТЕЙ.  
 
 
Эта глава поможет Вам самостоятельно справиться с некоторыми 
неисправностями, которые могут возникнуть в процессе эксплуатации плоттера. 
При возникновении каких-либо неисправностей в работе плоттера, прежде всего, 
убедитесь, что условия эксплуатации соблюдаются должным образом. 
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Примечание: 
Перед началом сервисного вмешательства, 
убедитесь, что неисправность заключается в 
работе самого плоттера, а не периферийного 
оборудования, например, рабочего компьютера, 
софт-программы или коммуникациях. 

 
 
 
 Почему плоттер не работает? 
 
 
 
 

 
Возможные причины: 
 
7.1. Несистемные неисправности. 
 
В первую очередь следует проверить: 
 Правильно ли подключен кабель питания. 
 Подается ли питание, соответственно нужным характеристикам электросети. 
 Горит ли индикатор подачи питания на рабочей панели. 

 
Решение: 
Если ЖК-дисплей находится в рабочем состоянии, выключите плоттер и 
включите снова. 
 
Если ЖК-дисплей не работает, обратитесь в сервисный центр Вашего 
регионального представителя GCC. 
 
7.2. Операционные неисправности. 
 
Причиной подобных неисправностей могут стать некоторые сбои работы 
механических частей плоттера. В подобных случаях на ЖК-дисплее высвечивает 
сообщение, содержащее информацию о виде неисправности и рекомендации по 
ее устранению. Если после выполнения рекомендуемых действий неисправность 
не удалось устранить, обратитесь в сервисный центр Вашего регионального 
представителя GCC. 
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Это сообщение говорит о том, что неисправности 
возникли в связи со сбоем функционирования Х-
мотора или основного вала. Проверьте рабочее 
состояние вала и правильность загрузки 
материала. Устраните неисправность и 
перегрузите плоттер. 

 
 
 

Это сообщение говорит о возможном 
затруднении движения каретки, которое может 
привести к неисправности в работе Y-оси. 
Проверьте ход движения каретки и 
перезапустите плоттер. 

 
 

 
Это сообщение говорит о возникновении 
неисправности в работе каретки. Перезапустите 
плоттер и, если неисправность не исчезла, 
обратитесь в сервисный центр регионального 
представительства GCC. 

 
 

 
Это сообщение говорит о том, что размер 
изображения превышает габариты рабочего 
материала. Загрузите материал большей площади 
или уменьшите обрабатываемое изображение в 
софт-программе или графическом редакторе. 

 
7.3. Затруднения в передаче данных. 
 
Сообщение, отображенное ниже, говорит о неисправностях в коммуникационной 
системе плоттер/компьютер. 
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Проверьте, правильно ли 
подключен коммуникационный 
кабель соединения плоттера и 
рабочего компьютера. 

 
 
 
 

 
Да      Нет 

 Проверьте, 
правильно ли был 
настроен интерфейс? 

См главу 2 
“Подключение 
плоттера”. 
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Да           Нет 

Проверьте связь между 
плоттером и 
компьютером. Если 
неисправность не удалось 
устранить, обратитесь в 
сервисный центр. 

См описание клавиши 
MISC в главе 3, настройка 
портов. 

 
Примечание: 
Компьютер также должен быть совместимым с параметрами плоттера. 

 
 Если плоттер не распознает HP-GL или 
 HP-GL/2 команды, проверьте 
 правильность использования этих команд. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
7.4. Неисправности в софт-программе. 
 
В первую очередь проверьте следующее: 
 
 Указано ли на упаковке сотф-программы, что она 

предназначена для работы плоттера и Вашего рабочего 
компьютера? Поддерживает ли софт-программа команды 
формата HP-GL и HP-GL/2? 

 52

 
 
 
 (* Проверьте настройки конфигурации софта) 
 

Да        Нет 
 Соответствует ли интерфейс 

плоттера требованиям софта? 
Режущие плоттеры GCC 
разработаны в соответствии 
с самыми известными 
мировыми софт-
программами для резки. 
Если софт не поддерживает 
плоттер, используйте софт-
программы, эмулирующие 
форматы HP-GL или HP-
GL/2. Вы сможете выбрать 
три драйвера: 
- формат А3: HP7475A 
- формат А1: НР7580А 

 
 
 

Да      Нет 
 
 
 
 
 
 
 
 

 
Да      Нет 
 
Попробуйте 
использовать 
другой кабель. 
 
 

 
 
 
 
 
 
 
 
 
 
 

- формат А0: HP Draft Exl 
или HP Draft Master 

Рекомендовано 
ли софт-
программой 
использование 
различных 
кабелей 
соединения? 

 См главу 2 
“Подключение 
плоттера”. 

Обратитесь 
к 
поставщику 
софт-
программы. 

Перезапустите 
плоттер и 
попытайтесь 
отправить файл 
заново. 

Есть ли в софт-программе пробные файлы? 

Да Нет 



 
 
7.5. Неудовлетворительное качество резки. 
 
 

Примечание: важно должным образом 
осуществлять ежедневное обслуживание 
режущего плоттера. Для достижения наивысшего 
качества резки и точности следите за чистотой и 
состоянием основного вала и прижимных 
роликов. 

 
 
 
 
 
 
 

Правильно ли установлен нож и закреплен ли 
должным образом держатель ножа? 

 
Да 

Проверьте, не 
затупилось ли лезвие. 
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См главу 2 
“Установка ножа”. 

 
Замените 
лезвие. 

Проверьте правильность параметра 
силы давления ножа. По умолчанию 
он равен 80см/гр. 

 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

 
 
 
 
 

Установите нужное 
значение силы давления 
ножа. См главу 4.3. 

Верно ли задан 
параметр Offset? 

Нет ли какого-либо 
мусора на лезвии? Задайте нужное 

значение Offset. 

Удалите налипший 
мусор и очистите 
лезвие. 

Обратитесь в центр 
сервисной поддержки. 

Да 

Нет 

Нет 

Да

Да Нет 

Нет 

Нет 

Да 



 
 

СПЕЦИФИКАЦИЯ JAGUAR IV. 
 
Модель J4-61 J4-101S J4-132S J4-183S 
Метод обработки Рулонный 
Макс ширина резки 610мм 1016мм 1320мм 1830мм 
Макс длина резки 50м 
Макс ширина рулона 770мм 1270мм 1594мм 1900мм 
Мин ширина рулона 8,5см 12см 19см 
Кол-во приж. роликов 3 4 6 
Допустимая толщина 
материала 

0,8мм 

Двигатели Сервоприводы 
Сила давления 0 – 600гр 
Макс скорость резки 1530 мм/сек 
Ускорение 4,2G 
Offset 0 – 1.0мм 
Буфер памяти 4МВ 
Интерфейсы USB1.1, LPT, COM (RS-232C) 
Тип команд HP-GL, HP-GL/2 
Мех точность 0,00625мм 
Точность софта 0,025мм 
Повторение ±0,1мм 
Кривые и сглаживание Да 
Программируемая 
точка входа (начало 
координат) 

 
Да 

Резка тестов Да 
Тангенциальная 
эмуляция 

Да 

Повтор Да 
Копирование Да 
Контрольная панель 2-х строчный ЖК-дисплей, 14 клавиш, индикатор 

питания 
Электросеть AC 100~240V, 50-60Hz 
Потребление Макс. 110Вт 
Габариты (ДхШхВ)мм 414*930*490 1166*1430*

667 
1166*1754* 

667 
750*2170* 

1160 
Вес 37,2кг 53,3кг 61кг 105кг 
Стойка Опция Стандарт 
Модуль AAS Стандарт 
Корзина Опция 
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Температура 10°С ~ 35°С 
Влажность 25% ~ 75% 
 
• Характеристики, приведенные в спецификации могут изменяться в 

зависимости от типа обрабатываемого материала. Для того, чтобы достичь 
производства наиболее качественной продукции, соблюдайте правила 
повседневного ухода за оборудованием. 

• GCC оставляет за собой право вносить изменения в спецификацию без 
уведомления. 

 
 

СПЕЦИФИКАЦИЯ НОЖЕЙ. 
 

Для резки толстой флюоресцентной и отражающей виниловой 
пленки, а также для точных работ на стандартной пленке. 

 
26500057G 

Лезвие 45° с красным наконечником, Offset 0.25мм 
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Для резки отражающей пленки, картона, волокна или трафарета 26500058G 
Лезвие 60° с зеленым наконечником, выступ лезвия 0,5мм 

 
Для резки шаблонов и трафаретов 26500059G 
Лезвие 60° с синим наконечником, выступ лезвия 0,25мм 

 
Для резки мелких символов. 26500060G 
Выступ лезвия 0,175мм с черным наконечником. 

 
 
 
Об инструменте. 
 
Значением Offset лезвия называется расстояние, на которое смещена режущая 
кромка (вершина лезвия) от оси симметрии. 
 
 
 
 
 
 
 
 



 
 

 

Лезвие 

Ось симметрии 

Режущая кромка 

 
Длина выступа лезвия 
 

 

Толщина 
материала t1 

Длина выступа 
лезвия 

Толщина 
подложки t2 

 
Длина выступа лезвия = t1 + t2/2, но в то же время длина выступа лезвия должна 
быть в пределах 0,3 ~ 0,5мм. 
 
 
 

 56



 
 

ИНСТРУКЦИЯ ПО CORELDRAW. 
 
Модуль AAS II поддерживается версиями CorelDraw 11, 12 и 13 
 
Инсталляция 
 

1. Выберите “AAS CorelDraw Installer” в меню инсталляционного диска, 
запустите файл “AASIIVBAInstaller.exe”. 

 
 

2. Нажмите “Install” и запустите GCC AASII CorelDraw VBA. 
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Инструкция пользователю 
 

1. Запустите CorelDraw, выполните требуемое редактирование файла, который 
хотите напечатать. Выделите все изображения. 

 

 
 

2. Нажмите кнопку Run a VBA Marco 
 

 
Появится окно Visual Basic for Application Marcos. 
Выберите GCC_CorelDraw_AASII (GCCAASII_Draw.gms) и нажмите “Run”. 
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3. Нажмите “Apply”. 
 
4-Point Positioning 
• Length: длина меток 
→ диапазон: 10мм – 50мм 
→ рекомендуемая: 25мм 
• Thickness: толщина линий меток 
→ диапазон: 1мм – 2мм 
→ рекомендуемая: 1мм 
• Margin: расстояние между метками и 

изображением 
→ диапазон: 1мм – 50 мм 
→ рекомендуемая: 5мм 
Segmental Positioning 
• X Step: промежуточное расстояние 

между позициями по оси Х 
• Y Step: промежуточное расстояние 

между позициями по оси Y 
→ диапазон: 200мм – 600мм 
→ рекомендуемая: менее 500мм 
Multiple Copies 
• No. of X Copies кол-во копий по Х 
• No. of Y Copies кол-во копий по Y 
→ диапазон: 1 – 50 (чем больше   

       количество копий, тем дольше время 
       передачи данных). 

• Copies with outline: показывает контур. 
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Программа создаст четыре необходимых метки на листе. 
 

 
 
4. Теперь Вы можете запускать модуль AAS II непосредственно с плоттера. 
 
Вы можете также установить значок для AASII. 
Шаг 1: Выберите “Tool→Customization→Commands→Macros”. 

 
 
Шаг 2: Выберите файл [GCC_CorelDraw_AASII.GCCModule.GCC_AASII] и 
перетащите его в “commands”. 
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Шаг 3: Если Вы захотите поменять значок, выберите “Tools→ 
Customization→Commands→Appearance” для импорта изображения. Выберите 
значок и нажмите OK. 
 

 
 
 

ИНСТРУКЦИЯ ДЛЯ SingPal 8.5. 
 
Инсталляция SingPal 
Для установки программы необходимо иметь права доступа администратора. Для 
того чтобы использовать программу, необходимо иметь права доступа 
администратора или основного пользователя. 

1. Деинсталлируйте все предыдущие версии программы (если таковые были 
установлены). 

2. Вставьте инсталляционный DVD. 
3. Выберите язык и нажмите ОК/ 
4. Нажмите NEXT 
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5. Прочтите условия соглашения и выберите “I accept the terms of the license 
agreement” и нажмите NEXT. 
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6. Если предыдущие версии не были установлены, пропустите этот пункт. 
Если установлена какая-либо из предыдущих версий программы, 
необходимо заменить ее. В появившемся окне нажмите YES. 

 
 

7. Выберите предложены пакеты, которые Вы хотите установить и нажмите 
NEXT: 

 
• Выберите GCC Production Suite для установки программы. 
• Выберите Samples для загрузки образцов файлов. 
• Выберите SafeNet Sentinel System Driver для установки этого ключа. Его 

можно не устанавливать, если пользователь е планирует работать с ним. 
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А. Для того, чтобы изменить папку установки, нажмите Browse и выберите 

новую папку. 
В. Для установки драйвера, убедитесь, что места на диске достаточно: 
 а) Нажмите Disk Space. 

b) В появившемся меню выберите драйвер, который необходимо 
установить. 

 с) Нажмите ОК.  
 

8. Выберите программную папку, где будет установлена программа. Для 
данного продукта будет автоматически создана папка. 

9. Для запуска установки программы нажмите NEXT. 
 

 
 

10.  После окончания установки программы появится окно “Installer Manager”. 
Install Manager позволит запустить демо версии всех предлагаемых 
продуктов или предложит ввести пароль для получения доступа к 
программе и всем доступным опциональным приложениям. 

11.  Выполните одно из следующих предложений: 
• Выберите Run in demo mode для запуска демо версий всех доступных 

приложений. 
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• Введите пароль, затем выберите нужное из списка Product и язык из списка 
Language. Для ввода дополнительных паролей в разделе Optional Password 
используйте клавишу Add. 



 
 
Password  окно ввода пароля для базового модуля программы. 
Optional Password в это поле Вы можете ввести дополнительный пароль для 

получения доступа к опциональным дополнениям 
программы. 

 
 
12.  Нажмите Done. 
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13.  Выберите значок, соответствующий теме, которую хотите установить: 
• Нажмите Install to Desktop, если хотите установить значок программы на 

рабочем столе. 
• Выберите Install to startup items для установки значка программы в 

стартовом меню Windows. При выполнении этой настройки при каждом 
запуске Windows программа будет запускаться автоматически. 

• Либо выберите Clear Application’s previous preference чтобы удалить все 
предыдущие ссылки. 

• Нажмите ОК. 

 
 

14.  Откройте SignPal 8.5v1 
 
 
 
 
 
 
 
 
 

 66



 
 

 
 

15.  Если Вы прежде не регистрировались, нажмите NEXT для регистрации. 

 
 

16.  Введите Ваши персональные данные. 
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17.  Если Вы регистрировались ранее, введите Ваш регистрационный код в 
графу Registration ID для запуска программы SignPal8.5v1. 
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Разрешение удаленного доступа к программе 
Вы можете активировать доступ к пользованию программой на другом 
компьютере. 

1. В меню Help выберите пункт Registration, Transfer License. 

 
 

2. Нажмите Yes, чтобы деактивировать разрешение работать с программой на 
текущем компьютере. 

 
Вы можете активировать доступ заново на этом же или на любом другом 
компьютере. 
 

3. Введите Ваш регистрационный код (Registration ID) и нажмите OK. 
4. Теперь Вы можете установить программу на нужный компьютер. 

 
Быстрый запуск модуля AASII в SignPal. 
• GCC AASII 

1. Откройте изображение и выберите элементы для AAS. 
2. Введите контур резки (Effect>Contour Cut. Затем кликните “Apply”). 
3. Укажите метки для модуля AAS (Effect>Contour Cut Mark. Выберите “GCC 

AASII” и нажмите “Apply”). 

 
 

4. Для режима “Multiple Copies” выберите “Arrange>Step and Repeat”. 
Пропустите этот пункт. Если нужно сделать только одну копию. 
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Примечание: Расстояние по вертикали и горизонтали должно быть ≥ 20мм или = 
0мм. 

 
 

5. Распечатайте изображение для модуля AASII (масштабирование 100%). 
6. Загрузите картинку в плоттер, нажав “File>Cut Contour” для отправки 

данных. 
 
• GCC Segmentation 

1. Откройте изображение и выберите элементы для модуля AASII. 
2. Выделите контур для резки (Effect>Cut Contour). 
3. Укажите метки для резки сегмента по контуру (Effect>Contour Cut Mark). 
4. Распечатайте изображение для модуля AASII (масштабирование 100%). 
5. Загрузите картинку в плоттер, нажав “File>Cut Contour” для отправки 

данных. 
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ИНСТРУКЦИЯ ДЛЯ EasySIGN 
 
Инструкцию пользователя программы EasySign Вы можете найти на 
установочном диске или по ссылке: 
http://www.easysign.com/mainwebv1/DownGT.aspx. 
 
GCC AASII Corpmark System 
Это приложение показывает как использовать систему GCC AASII Corpmark. 
Необходимо убедиться, что плоттер установлен правильно и способен выполнять 
простые задания на резку. Если нет, следуйте в раздел “Getting Started” 
инструкции в меню “Help, Various, GettingStarted.pdf”. 
 

1. Создайте или импортируйте изображение. 
 

 
 
Вы можете легко создать любой рисунок в программе EasySIGN или 
импортировать его из другого приложения. Для создания изображения в 
EasySIGN следуйте ссылке “Getting Started” по инструкции. Для импорта 
изображения из другого приложения (например, файл Adobe Illustrator) 
используйте любую совместимую опцию. Запустите EasySIGN, затем 
используйте меню “File, Compatibility” и выберите нужную программу. 
Программа запущена и может быть использована для создания изображения 
или для открытия уже готового файла. 
Либо используйте непосредственно команду импорта (меню: “File, Import”). 

 
2. Создание контура резки. 
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http://www.easysign.com/mainwebv1/DownGT.aspx


 
 
После импортирования изображения в программу EasySign, следует выбрать 
линии резки. После того, как их выделили, используйте команду “Edit, Convert 
to, Line type, Print&Cut line”. Теперь линии, по которым будет производиться 
резка отображены красным пунктиром. 

 
3. Указание меток. 
 

 
 
Правым кликом мыши щелкните на пустую часть рабочего листа и выберите 
команду “Cropmark setting”. 
 

 
 
Появится диалоговое окно. 
Выберите раздел “Show Print & cut cropmarks”. 
Далее необходимо указать, какой из трех возможных режимов Вы хотите 
использовать для задания меток. 
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GCC AASII Режим использования четырех меток для одной копии 
изображения. Рекомендуется для работы с 
небольшими изображениями (60см и менее) в 
случаях, если собираетесь напечатать только один 
лист. 

GCC AASII, Multicopy Используйте этот режим, если хотите обрабатывать 
несколько маленьких изображений в одном задании. 
Это позволит Вам достичь высокой точности резки, 
но т.к. плоттер будет обрабатывать каждый контур 
отдельно, то скорость будет небольшая по сравнению, 
например, с резкой одного крупного файла. 

GCC AASII, Multisegment Используйте этот режим при работе с крупными 
изображениями. Рекомендуется для элементов резки, 
более 60см. Рекомендуется также разместить 
несколько дополнительных меток на листе, чтобы 
добиться большей точности. Но это займет 
дополнительное время при их сканировании. 

 
Размер меток фиксированный и равен 25мм. Нажмите ОК для закрытия 
диалогового окна. Если Вы использовали режим Multicopy, необходимо будет 
ввести дополнительные данные по количеству копий по горизонтали, 
вертикали и т.д. На данном этапе пропустите эти настройки, мы вернемся к 
ним позже. 
 
4. Позиционирование меток. 
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Для обозначения меток используйте функцию “Panelling Tool” панели 
инструментов, располагающейся в левой части экрана. Убедитесь, что вокруг 
меток есть свободное белое пространство, и в обозначенном метками 
диапазоне нет других объектов кроме объектов резки. 

 
5. Экспорт задания. 
Теперь изображение готово для дальнейшей обработки. Нажмите “File, 
Export”, появится диалоговое окно, позволяющее создать файл. Рекомендуется 
использовать формат “EPS Encapsulated Postscript (*.EPS)”, чтобы файл мог 
быть считан программой RIP или другими печатными программами. 
Напечатайте картинку. 

 
6. Резка по контуру. 
Загрузите отпечатанный материал в плоттер. Переведите плоттер в режим 
Offline и используя клавиши стрелки установите диод красного лазера 
оптической камеры с соответствии с положением нижней правой метки. Затем 
переведите плоттер в режим Online. 
 

 
 
Если Вы выбрали функцию Multicopy, необходимо будет выполнить одно 
дополнительное действие. Щелкните правым кликом на рабочей странице и 
снова зайдите в меню “Cropmark settings”.  
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В этом окне введите количество копий по горизонтали и вертикали, а также 
расстояние между копиями в обоих направлениях. Затем нажмите ОК. 
 
В программе EasySign выберите “File, Plotting”. Появится окно, которое 
позволит задать параметры плоттера. 
 

 
 
Убедитесь, что настройки соответствуют следующим (см рисунок выше): 
 
Alignment plotting (1) Метка стоит 
Normal line (2) Метка не стоит 
Print and cut line (3) Метка стоит 

 
Нажмите ОК. 
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